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Introduction 

 

Introduction 

 

This section provides valuable information about teaching TechnoBiography. It 

includes an overview of the course. In addition, there are ideas for 

implementation and technology integration. 

 

For additional guidance, open the course in TechnoHub and select Get 

Started to access preparatory steps, resource list, and scheduling timetable. 

 

TechnoBiography Overview 

TechnoBiography Course Outline 

Technology Integration Ideas 
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TechnoBiography Overview 

In this course, students become biographers writing about a person's life 

story using Word 365. To start, they research a notable figure who has 

made a difference in the world. Once familiar with events and 

achievements, students summarize a personal history using heading 

styles to organize events logically. Contributions are highlighted using a 

graphic organizer. To help readers connect with the person, artifacts 

with links to additional information are arranged in a table. Sources of 

information are cited using a bibliography. Upon completion, the 

biography is shared with readers. Extension activities challenge students 

to customize page layout, connect information with bookmarks, or 

create awards of distinction. 

 

Students complete the following tasks: 

 

➢ In Session 1, students become biographers. They prepare to write about the life 

story of a remarkable person. To start, they view a sample biography about a 

famous astronaut to understand how a person's history and achievements can 

be summarized. Next, they brainstorm a topic for their own publication. It could 

be about an inventor, explorer, athlete, or artist. There are so many possibilities! 

➢ In Session 2, students research a significant person's history and accomplishments. 

The biography should highlight early experiences that influence the person's 

future, the importance of their achievements, and events that demonstrate their 

personality. Using tertiary, secondary, and primary sources of information students 

prepare to write a life story. 

➢ In Session 3, students begin to write the biography. They gain valuable word 

processing skills as they create a title page. Next, they build the document 

structure using heading styles. There will be sections for personal history, 

contributions, media gallery, and a bibliography. Once the framework for the 

publication is complete, they use the heading styles to make a table of contents, 

which will allow the reader to quickly find relevant information. 

➢ In Session 4, students start to write the biography. They rephrase their researched 

information to summarize details about the person's early life, family, education, 

and career. Transition words are provided to help students connect ideas. Next, 

they create a SmartArt graphic that highlights accomplishments. To engage 

readers, an optional activity explains how to design a “bumper sticker” with an 

inspirational message associated with the person. 

➢ In Session 5, students design a Media Gallery. It will include artifacts of objects 

from a person's life, such as a video of a performance, link to a speech, or image 

of a birth certificate. This will help readers form a connection to the person. A 

table is used to organize the information. Upon completion, students make a 

bibliography that summarizes their list of sources. To add interest, an optional 

activity explains how to bookmark a location in a document to connect 

information in the Personal History section to an artifact in the Media Gallery. 

➢ In Session 6, students share their biography with readers. They select an option for 

publishing. It could be printed or digital. Prior to publication, an extension activity 

explains how to customize page layout. Students can adjust the page margins, 

add headers and footers, and modify line spacing. If time permits, discuss the 

contributions of the significant person with others. Why are they a source of 

inspiration? 

 



  Getting Started 

Copyright © TechnoKids Inc. iii TechnoBiography | Microsoft 365 

TechnoBiography Course Outline 
  

Purpose: Write a biography about a person that 

has made a difference in the world. 
Preparation: 

• Install Microsoft 365: Word 

• Share Biography folder with students 

• Download Word 365 flashcards or tool 

summary from TechnoHub. 

 

Objectives: (see Appendix A: Skill Summary) 

• brainstorm a topic 

• conduct research using a variety of sources 

• collect artifacts and interpret their meaning 

• organize notes in a logical order 

• analyze life events to draw conclusions 

• explain the importance of a person 

• cite sources in a bibliography 

• use styles to layout document structure 

• highlight contributions in a graphic organizer 

• connect artifacts to the person using a table 

• format text, images, and shapes 

• publish a biography 

Materials: 

• Brainstorm a Topic handout 

• Research Checklist, Biography Checklist, 

Research Marking Sheet, Biography Marking 

Sheet, Biography Skill Summary 

• Parent Letter and Certificate (optional) 

• Word 365 Flashcards and Tool Summary 

(optional) 

• Biography folder 

o Samples: Astronaut, Artist, Politician 

o Organizer template 
  
 

Summary of Activities: 

• Understand the role of a biographer. Study sample biographies. 

• Brainstorm a topic for a biography. Select a notable person. 

• Research basic facts using an encyclopedia. Record information using an organizer. 

• Continue to research using secondary sources to gain a deeper understanding of the person's life. 

• Collect artifacts directly connected to the person. Analyze the primary sources to draw conclusions. 

• Complete a research checklist to confirm readiness to write a biography. 

• Create a title page for the biography. 

• Set document structure by adding heading styles and inserting a table of contents. 

• Write a personal history. Summarize the person's early life, family, education, and career. 

• Make a graphic organizer of accomplishments. Explain their importance. 

• Design a media gallery of artifacts using a table. Describe their connection to the person. 

• Cite sources of information in a bibliography. 

• Complete a biography checklist. Edit the document based on the assessment. 

• Share biography with readers as an eBook. Use questions to make a connection to the reader. 
 

Extension Activities: 

• Create a School Award: Design a certificate of recognition named after the person. 

• Make a Bumper Sticker: Use drawing tools to make a saying or quote based on the person's life. 

• Insert a Video: Insert a video clip into the Media Gallery. 

• Link Artifacts Using Bookmarks: Insert a link that connects to a bookmarked artifact. 

• Customize Page Layout: Adjust margins, insert headers/footers, or set line and paragraph spacing. 
 
 

Assessment: 

• Self-Evaluation (Research Checklist, Biography Checklist) 

• Teacher Evaluation (Biography Skill Summary, Research Marking Sheet, Biography Marking Sheet) 
 
 

Notes: 

• It is recommended students have background knowledge about a historical period or social 

context related to the person being studied. 

• Although samples are provided, it is beneficial for students to read biographies or watch 

documentaries to gain familiarity with the biography genre. 

• The more current the person, the more digital content available on the Internet. 

https://technohub.technokids.com/
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Technology Integration Ideas 

In TechnoBiography, students become biographers. They write a biography about a notable 

person using Microsoft Word. The activities integrate into curriculum and can be included into 

language arts, history, social studies, science, art, or computer studies. 

• Write a Life Story: Practice expository writing. Write an engaging life story that offers insight 

into a person. Captivate the reader’s attention. 

• Celebrate a Historical Figure: Develop a deeper understanding of a historical period. 

Research the contributions of a historical figure. Explain their importance to the past and 

influence on future events. 

• Acknowledge a Hero: Inspire others with the accomplishments of personal hero, role model, 

mentor, or newsmaker. Detail their successes and challenges. Outline reasons their efforts are 

admirable. 

• Investigate Scientific Contributions: Appreciate amazing research findings and inventions. 

Outline the path to discovery of a scientist. Explain how their work has improved the lives of 

others. 

• Appreciate the Arts: Learn about an art period or artistic style by studying a famous artist. 

Examine their artwork. Describe its meaning and how it influenced other artists. 

• Develop Word Processing Skills: Introduce word processing skills in a computer studies course. 

Learn to customize styles, insert a table of contents, draw a graphic organizer, organize data 

using tables, adjust page layout, and add bookmarks. 

 

Understanding the Big Picture 

 

Not sure where to integrate TechnoBiography? There are three samples provided for this course. 

These samples provide ideas on how you can include these activities in the curriculum. 

 

✓ Astronaut: A modern-day explorer, John Glenn's remarkable life as a military leader, pilot, 

astronaut, and senator, is an inspiration to others. 

✓ Artist: A Canadian artist, paintings by Emily Carr capture the beauty of the Canadian 

landscape. 

✓ Politician: A statesman, Winston Churchill played a major role in leading the Allies to 

victory in World War II using his strong leadership. 

 



 

 

 

Session 1 Become a Biographer 

 

Session 1 
Become a Biographer 

 

In this session, students become biographers. They prepare to write about the 

life story of a remarkable person. To start, they view a sample biography about 

a famous astronaut to understand how a person's history and achievements 

can be summarized. Next, they brainstorm a topic for their own publication. It 

could be about an inventor, explorer, athlete, or artist. There are so many 

possibilities! 

 

Assignment 1: What is a Biography? 

Assignment 2: Brainstorm a Topic 
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Assignment 1 What is a Biography? 

You are going to become a biographer. A biographer is someone that writes 

about the life story or biography of a remarkable person. You will share your 

biography with readers. 

 

What is a Biography? 

 

A biography is a description of someone's life written by another person. It provides a summary 

of their personal history, explains the importance of their contributions, and offers insight into their 

personality. Often a biography will include photographs, video clips, or personal documents.   

 

What facts can be included in a biography? 

• Birth 

• Death 

• Early Life 

• Family and Significant Relationships 

• Education 

• Career 

• Accomplishments 

• Life Challenges 

 

Understand the Role of a Biographer - Get Personal 

 

List important information about yourself. 

 

1. When were you born?  

  

2. Who are the members of your family?  

  

3. What is the name of your school?  

  

4. What trophy, prize, or certificate have you earned?  

  

5. Read your answers. Does the information tell people who you really are? 

What information would help people know about you and what makes you special? 

  

  

6. If a biographer was writing a book about you, what items or events should they study to 

learn about you? 
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Study Sample Biographies 

 

A biography is more than a list of facts. It should be PERSONAL! A reader should 

feel as if they know the person after they are done reading the information. 

 

Study sample biographies to get ideas for writing your own biography. 

 

 Open Astronaut  in the Biography folder. 

Answer the questions. 

7. Who is the biography about? 

 John Glenn 

 

8. Look at the front cover. What has he done that makes him remarkable? 

 He was a military leader, pilot, astronaut, and a senator. 

 

9. View the headings in the Personal History section of the biography. 

 What main headings are included? 
  

 ●  Early Life and Family 

 ●  Education 

 ●  Career 

 ●  Follow your Dreams 

 

10. A graphic organizer is used to summarize the person's contributions. 

What achievement do you find the most important? 

  

 

11. A table is used to organize artifacts connected to the person. 

Click on the name of each artifact. Which artifact do you find most interesting? 

  

 

12. A bibliography lists sources of information used to write the biography. 

How can you use the bibliography to learn more about the person? 

 Visit each website to read additional information. 

 Close the biography. 

 

 

View the Artist and 

Politician biographies to 

get even more ideas! 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 



 

 

 

Session 2 Research a Hero 

 

Session 2 
Research a Hero 

 

In this session, students research a significant person's history and 

accomplishments. The biography should highlight early experiences that 

influence the person's future, the importance of their achievements, and 

events that demonstrate their personality. Using tertiary, secondary, and 

primary sources of information students prepare to write a life story. 

 

Assignment 3: Research using Tertiary Sources 

Assignment 4: Research using Secondary Sources 

Assignment 5: Research using Primary Sources 

Assignment 6: Research Checklist 

 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 
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Assignment 5 Research using Primary Sources 

You cannot rely solely on tertiary or secondary sources of information 

when writing a biography. You need to draw your own conclusions 

about a person. The best way to do this is to study raw data.  
 

Biographical research requires a biographer to collect and analyze 

artifacts from a person's life.  
 

The artifacts are primary sources of information. They are valuable 

because they offer first hand evidence of a life event. Primary sources help biographers to gain 

an understanding about a person's actions, ideas, beliefs, or emotions. 

 

Types of Primary Sources  

 

A primary source of information is an original artifact that has a direct connection to the person.  

What did the person say or write? 

• speech or transcript 

• journal article 

• diary entry 

• letter or email 

• notebook 

• postcard 

• interview 

• personal blog 

• telegram 

• autobiography 

• social media post by person 

• video testimonial 

What documents relate to life events? 

• birth certificate 

• marriage license 

• school report card or diploma 

• contract or agreement 

• membership card  

• act or treaty 

• warrant 

• passport or citizenship certificate 

• driver's license 

• property deed 

• baptism certificate 

• will 

What did the person make? 

• book or poem 

• artwork 

• song sheet 

• play 

• manuscript 

• invention 

• architecture 

What did the person do? 

• photograph 

• video footage of live event 

• audio recording of live event 

• newspaper article of live event 

• eyewitness account of live event 

• medieval tapestry 

• experiment results 

What awards of recognition were given? 

• trophy or plaque 

• medal or prize 

• certificate of recognition 

What items did the person own? 

• vehicle 

• clothing or jewelry 

• instrument 

 

 
  

Primary Source Tips: 
 

✓ Timing Matters: A primary source is created at the time of the event or shortly thereafter. 

✓ No Judgement: A primary source is raw data and has not been interpreted by someone 

else. 

✓ Verify Authenticity: Check the source of the artifact. It should be posted by a reliable source 

such as a museum, reputable organization, or official fan club. 

✓ Copy of Original: A primary source is often one-of-a-kind or rare. Since there is a limited 

number, the artifact can be the actual item, digital copy, or exact replica. 
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Collect Artifacts 

 

 

 Open your Organizer in Word.  

 Record information about each artifact. 

Item Name Importance 
URL (picture of artifact, news story 

about item, video of artifact in use) 

   

   

   

 

 

 
 

Use the Internet to collect three primary sources. Try to find a variety. 

Where possible, save a picture of the artifact to include in your 

biography. If it is a video, save the URL.  

Interpret Importance: Study the artifact. Ask yourself questions to discover its importance. 

• Why did you pick this artifact? Why did it attract your attention? 

• What do you notice about the artifact? What makes it interesting? 

• Why do you think the artifact was created? Who is the audience? 

• What does the artifact tell you about the person's personality? 

• What feelings or ideas do you think are being expressed? 

• What does the artifact tell you about the time period, or society? 

• Did the artifact influence future events? 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 



 

 

 

Session 3 Create Document Structure 

 

Session 3 
Create Document Structure 

 

In this session, students begin to write the biography. They gain valuable word 

processing skills as they create a title page. Next, they build the document 

structure using heading styles. There will be sections for personal history, 

contributions, media gallery, and a bibliography. Once the framework for the 

publication is complete, they use the heading styles to make a table of 

contents, which will allow the reader to quickly find relevant information. 

 

Assignment 7: Create a Title Page 

Assignment 8: Set the Document Structure Using Styles 

 

Session 3 Extension Activity: Create a School Award 

 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 
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Assignment 8 Set the Document Structure Using Styles 

In this assignment, you set the document structure using heading styles. 

Heading styles identify the type of information. They clearly show the reader 

the difference between main headings and subheadings. 

 

Open the Biography in Word  

 

Insert a Page Break 

 

Your biography will have an interactive table of contents that takes readers directly to 

information in the biography. To start, you need to make a new page. To do this, you 

must insert a page break. A page break can be used to add a blank page or divide 

content onto separate pages.  
 

 Place the cursor at the END of the front cover. 

or press CTRL+END to move the cursor to the end of the document. 

 From the Insert tab, click Page Break.  

 
 

Type Table of Contents Title on the New Page 

 On the new page, type Table of Contents. 

Press ENTER twice. 

 

Add Document Headings 

 Use your skills to insert a new page.  

On the new page add the biography headings. Press ENTER twice after each heading: 

o Personal History 

o Early Life 

o Family 

o Education 

o Career 

o Contributions 

o Media Gallery 

o Bibliography  

page 1 

page 2 cursor 

You can change heading names 

or add additional headings. 

page break 
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Apply Heading Styles 
 

A heading style is a pre-set formatting option applied to text. You will use heading styles 

to organize information in the biography, create a consistent design, and automatically 

generate a table of contents. 

 

 

 Select the heading Personal History. 

 Click the Home tab and locate the Styles group. Select Heading 1.  

 

 Apply the Heading 2 style to:  

o Early Life 

o Family 

o Education 

o Career 

 Apply the Heading 1 style to: 

o Contributions 

o Media Gallery 

o Bibliography 

 

 

Customize Heading Styles 

 Select the heading Personal History. 

 Format the font , size , style    , color  , effect , and alignment  . 

 Right click Heading 1 in the Styles group of the Home tab.  

Select Update Heading 1 to Match Selection. 

 
 

 
 

 Use your skills to customize the Heading 2 style.  

  

Notice all the Heading 1 styles change. 

Heading 1 is a main heading. 

Heading 2 is a subheading. 

Select each heading separately 

so that the Heading Style is not 

applied to the spaces in 

between. This is where the facts 

will be written. They should be 

normal style. 
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Insert Table of Contents 

 View page 2. 

 Select the Table of Contents title. 

 Click the References tab. 

 Click Table of Contents.   

Select Automatic Table 1. 

 

 Look at the Table of Contents. Hold the CTRL key and click on a heading. 

− The cursor moves to that heading in the biography. 

 
 

 

 If you edit or add new headings, to update the Table of Contents: 

o Right click on the Table of Contents and choose Update Field.  

o Choose Update entire table. 

o Click OK. 

 

 

Save the Biography and Exit Word 

Each item in the Table of 

Contents is a hyperlink that 

connects to the page with 

the information. 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 



 

 

 

Session 4 Explain Accomplishments 

 

Session 4 
Explain Accomplishments 

 

In this session, students start to write the biography. They rephrase their 

researched information to summarize details about the person's early life, 

family, education, and career. Transition words are provided to help students 

connect ideas. Next, they create a SmartArt graphic that highlights 

accomplishments. To engage readers, an optional activity explains how to 

design a “bumper sticker” with an inspirational message associated with the 

person. 
 

Assignment 9: Write a Personal History 

Assignment 10: Make a Graphic Organizer of Contributions 

 

Session 4 Extension Activity: Make a Bumper Sticker 

 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 
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Assignment 10 Make a Graphic Organizer of Contributions 

A biography is more than a series of events organized in chronological order. Instead, the telling 

of a person's life story should explain why their contributions are important. 

 

Create a graphic organizer to summarize accomplishments that made a difference in the world. 

There are many ways to layout the information. Be creative! 

 

   
Basic Block List Radial List Basic Process 

Display accomplishments  

in separate boxes. 

Join accomplishments to  

a central contribution.  

Connect accomplishments in chronological 

order. End with their influence on today. 

 

 

Open Biography in Word 
 

Insert a Page Break (Optional) 

 If you do not have much room left on the Personal History page,  

place the cursor before the heading Contributions. 

 From the Insert tab, click Page Break.  

 
 

Insert a SmartArt Graphic 

 Place the cursor below the Contributions heading. 

 Click the Insert tab. 

 Click SmartArt.  

Pick a graphic. Click OK. 

− The SmartArt appears. 

 

Each shape holds text that is 

organized in levels. Information 

may be added in a Text Pane.  
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Describe the Importance of Accomplishments 

 If you cannot see the text pane, enable it by clicking Text Pane  in the Create Graphic 

group on the SmartArt Design tab. 

 Add the first item into the Text pane: 

o Beside the first bullet, type the Accomplishment Name. 

o Press Add Bullet  on the SmartArt Design tab.  

Provide details readers would find interesting. Press ENTER.  

o Explain the importance at the time or afterwards. Press ENTER. 

 Use your skills to add more accomplishments. 

 

 
 

 
 

Format the SmartArt Graphic 

 Select the SmartArt. 

 From the SmartArt Design tab, click the More arrow in the Layouts group. 

Select an option. 

 

 In the SmartArt Styles group, click Change Colors  . Pick an option. 

 Click the More arrow in the SmartArt Styles group. Pick an option. 

 

 Resize the SmartArt to fill the page.  

  

Want more shapes? Each shape is a main bullet. 

To add a new shape, press Add Shape.  

An indented bullet is text 

inside the shape about the 

accomplishment.  

Each main item is a shape 

in the SmartArt. The text is 

often a heading.  
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Add Pictures to the Graphic Organizer (Optional) 

 

There are two ways to add pictures to the graphic organizer.  

 

• Method A is for SmartArt layouts that include a picture placeholder.  

 

 

• Method B is for SmartArt layouts that are text only.  

 

 Method A - Insert a picture into a SmartArt placeholder: 

o Click the Insert Pictures placeholder.  

o From the Insert Pictures dialog box, pick Online Pictures.   

o In the search box, type name of person or object. Press ENTER. 

o Click on a picture you like. Click Insert. 

 
 

 
 

 Method B - Insert a picture on the same page as the SmartArt: 

o Click outside the SmartArt to make sure it is not selected. 

o From the Insert tab, click Insert Pictures.  

Choose Online Pictures.  

Use your skills to search for and insert a picture. 

o Select the picture.  

Click Layout Options and pick In Front of Text.  

o Resize  and place  the picture on the page near the  

SmartArt graphic. 

 

Save the Biography and Exit Word 

 

DESIGN TIP 

If the picture does not fit the placeholder frame, try the following: 

1. Click the Crop  menu on the Picture Format tab. 

2. Select an option: 

• Choose Fill  to resize the picture so the entire picture area is filled. This keeps 

the original aspect ratio. Any area of the picture that falls outside of the picture 

area will be cropped. 

• Choose Fit  to resize the picture so the entire picture displays inside the 

picture area. This keeps the original aspect ratio without cropping. 

 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 



 

 

 

Session 6 Share Your Biography 

 

Session 6 
Share Your Biography 

 

In this session, students share their biography with readers. They select an 

option for publishing. It could be printed or digital. Prior to publication, an 

extension activity explains how to customize page layout. Students can adjust 

the page margins, add headers and footers, and modify line spacing. If time 

permits, discuss the contributions of the significant person with others. Why are 

they a source of inspiration?  

 

Assignment 13: Biography Checklist 

Assignment 14: Share Your Biography with Readers 

 

Session 6 Extension Activity: Customize Page Layout 

 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 
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Session 6 Extension Activity: Customize Page Layout 

Make your biography look even better!  

Open the file and follow the instructions to alter the page layout. 

 

1. Open the biography in Microsoft Word. 

2. Adjust the page margins: 

 a. Click the Layout tab. Click Margins.  

 b. Select an option. 

 
 

 c. Preview the document and make any necessary changes. 
Note: The SmartArt graphic organizer and some images may not adjust to the margin changes. 

 

3. Insert a custom header: 

 a. Place the cursor on the title page.  

 b. Click the Insert tab. Click Header  . Choose Edit Header. 

 

 
 

 c. From the Options group of the Header & Footer tab, click Different First Page. 

 

 d. Click Next  to move to the header on the next page. 

 e. Add information to the header section: 

   Type Name of Person. Press TAB.   

   Type Biography. Press TAB.   

   Type By Student Name. 

 

4. Insert a custom footer: 

 a. From the Header & Footer tab, click Go to Footer . 

 b. In the footer section, use your skills to add information such as Class, Subject, Date, 

or Teacher Name. 

  

Choose Wide if you do 

not have much text or 

Narrow if you want to 

fit more on a page. 

Header 
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5. Insert a page number in the margins: 

 a. From the Header & Footer tab, click Page Number.  

 b. Select Page Margins. 

 c. Pick an option from the gallery. 

 

 

 d. From the Header & Footer tab, click Close Header and Footer.  

 

6. Change the line spacing of text: 

 a. Select the text you want to edit. For example, select text in the Media Gallery table. 

 b. From the Home tab, click Line and Paragraph Spacing.   

Select an option.  

 
 

7. Change paragraph spacing of headings: 

 a. Select a heading. 

 b. Click the Layout tab. Type a value in the Before and After Spacing boxes. 

 

 

 c. Click on the Home tab. Right click on the styles heading.  

 d. Select Update Heading to Match Selection to make all heading styles look the 

same. 
 

 

8. Save the biography and exit Microsoft Word. 

 

Drag the scroll box to 

see more options. 



 

 

 

Appendices 

 

Appendices 

 

Refer to the appendices for additional resources: 

 

Appendix A: Assessment Tools 

TechnoBiography Skill Summary 

Research Marking Sheet 

Biography Marking Sheet 

Appendix B: Contact Information 

 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 
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Research Marking Sheet 

Tertiary and Secondary Sources of Information 
 

• An encyclopedia was used to gather basic facts 

• At least two secondary sources of information were used to research. 

• Facts describe a person's life such as birth, death, early life, family, 

education, and career. 

• At least three accomplishments are outlined. 

• Information sources are recorded. 

• Information sources are trustworthy. 
/6 

Primary Sources of Information 
 

• There are at least three artifacts directly connected to the person. 

• Artifacts are from a reputable source and are authentic. 

• There is a variety of artifacts. 

• Artifacts tell about the person. 

• The importance of the artifacts is explained. 

• There is a URL for each artifact that offers additional information. 

• Readers will find the artifacts interesting. 
/7 

Organization of Facts 
 

• Facts are organized under headings. 

• Facts are arranged in chronological order. 
/2 

TOTAL /15 
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Biography Marking Sheet 

Title Page 

• Title is creative and attracts reader attention.  

• Tagline highlights what makes the person important.  

• Picture identifies the person. /3 

Personal History 

• Introduction explains why the person is important.  

• Description of the person's life is thorough.   

• Events are sequenced in a logical order.  

• Information is divided using appropriate headings.  

• Emphasis is placed upon significant events.  

• Conclusion defends why the person is remarkable.  

• Pictures enhance the message and are arranged attractively on the page. /15 

Contributions 

• Graphic organizer layout suits the content.  

• Graphic is formatted to produce a unique design.  

• Achievements are summarized to highlight their importance. /12 

Media Gallery 

• Artifacts are organized using a table.  

• Facts are in a bulleted list.  

• Descriptions for each artifact offer insight into the person.  

• Links for each artifact connect to interesting information.  

• Table style is appealing. /10 

Bibliography 

• Multiple sources of information were used to research.  

• Sources are organized in alphabetical order using a citation style. /2 

Layout 

• Document includes a table of contents.  

• Heading styles are used to categorize and order information.  

• Page breaks are used to divide content. /3 

Quality 

• Writing is in the style of a biography.  

• Spelling and grammar are correct.  

• Facts are rephrased and are not plagiarized. /5 

Comments: 

TOTAL: /50 

 



 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

This course includes a sample of a completed project. 
Teachers can use this resource for demonstration purposes 

or as a source of inspiration. 

 

 

 

 

 

 



The Amazing Life John H. Glenn 

Military Leader, Pilot, Astronaut, U.S. Senator 

 

 

 

 

By Jake Rayner 

  



John Glenn Biography Jake Rayner 

Mrs. Teacher 2 Class 7A 

Table of Contents 

 

Personal History ............................................................................................................................................ 3 

Early Life and Family ................................................................................................................................. 3 

Education .................................................................................................................................................. 3 

Career ........................................................................................................................................................ 3 

Military Leader and Pilot ....................................................................................................................... 3 

NASA Astronaut .................................................................................................................................... 4 

Senator .................................................................................................................................................. 4 

Follow Your Dreams .................................................................................................................................. 4 

Contributions ................................................................................................................................................ 5 

Media Gallery ................................................................................................................................................ 6 

Bibliography .................................................................................................................................................. 7 

 

 

 

 

  

Pursue Your Dreams



John Glenn Biography Jake Rayner 

Mrs. Teacher 3 Class 7A 

Personal History 
John Glenn was a famous military leader, pilot, astronaut, and senator. He was born July 18th, 1921 in 

Ohio. He died on December 8th, 2016. His fearless nature was an inspiration to others. 

 

 

Early Life and Family 
 

John grew up in New Concord, a small town in Ohio. As a young boy, he had an 

interest in science and flight. In 1943, he married Anna, his childhood friend.  

They were married for over seventy years, had two children, and grandchildren. 

 

 

Education 
John attended primary and secondary schools in New Concord. Afterwards, he 

went to Muskingum College to earn a Bachelor of Science degree in Engineering. In 1942, John joined 

the US Naval Aviation Cadet Program where he began to develop his superior piloting skills. Many years 

later he continued his flight training and graduated from the US Naval Test Pilot School. 

 

 

Career 
Military Leader and Pilot 

   

John’s military career began in 1943 when he joined the US Marine Corp. He 

flew 59 combat missions in World War II and later flew missions in the 

Korean war. In 1948, his passion for flying led him to join the Naval Air Test 

Center, where he served as a test pilot for Naval and Marine aircraft. He 

retired from the Marine Corps in 1965 as the rank of Colonel. 
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NASA Astronaut 

In 1959, John was looking for a new adventure. He joined NASA as a Project Mercury 

Astronaut. Only a few short years later, he would be the first American to orbit Earth 

in the Friendship 7 spacecraft. He served as an advisor to NASA until 1964, when he 

left to pursue public office. However, his love of space exploration continued 

throughout his life and 36 years after his flight into space he returned to NASA in 

1998 to be the payload specialist on the Discovery space shuttle. He was 77 years old! 

  

 

Senator 

In 1964, John wanted to become a senator. Unfortunately, his plans were 

derailed when he had an accident. He spent several years working as a business 

executive. In 1970, he ran again for senate but lost. He did not give up and in 

1974 he was elected to the US Senate. Senator Glenn served four terms. He liked 

politics and even ran for president, although he did not win. John retired from 

politics in 1999. 

 

 

 

 

Follow Your Dreams 
John had a fearless, adventurous spirit. His life story shows that you can be anything you want, whether 

it is a pilot, astronaut, or senator. He inspires others to pursue their dreams and never give up. 
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Contributions 
 

 

  

War Hero

•John Glenn flew missions in World 
War II and the Korean war. In the last 
nine days of fighting in Korea, Glenn 
downed three MiGs in combat along 
the Yalu River. He has been awarded 
many valor medals. 

•His military service helped to protect 
the US and their allies. 

Space Explorer

•John Glenn was the first American to 
orbit Earth. His flight lasted 4 hours, 
55 minutes, and 23 seconds. He is 
the oldest person to travel into space 
as part of the NASA STS-95 mission. 
His contributions to NASA provided 
the foundation for future 
engineering of spacecraft.

Speed Record Setter

•John Glenn flew at a record speed of 
725.55 mph from LA to NY in 3 
hours, 23 minutes, and 8.4 seconds. 
It was the first transcontinental flight 
to average supersonic speed. 

•The purpose of the Project Bullet 
flight was to test engine 
requirements for fighter jets. This 
helped engineers build better planes 
for combat missions.
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Media Gallery 
Connect with John Glenn Making a Difference 

Watch video from 0:53 to 2:00 

Watch the Gold Star Mothers Speech 

• In 1974, while running for senator, John 
Glenn gave a speech as part of a debate 
at the Cleveland City Club. 

• During the speech, he defends the 
importance of a soldier's job. This speech 
is in response to comments made by his 
opponent that he never held a job or had 
to make a payroll. 

• John Glenn was proud of his military 
service and this is a passionate speech. 
John won the senate election. 

 

 

 
 

View the Presidential Nominee Campaign Flyer: 

• In 1984, John Glenn ran in the 
presidential primaries for the Democratic 
Party. The primaries are a way for voters 
to pick the nominee to run for the 
President of the United States. 
Unfortunately, he did not get enough 
support, so he withdrew. 

• His slogan was Integrity Counts. He 
campaigned to increase public 
confidence in the government, fight 
inflation, develop a national energy 
policy, and have national health 
insurance. 

• John Glenn wanted to improve the lives 
of Americans. 

 

Read the White House Press release or ceremony 
transcript.  

Read the Medal of Freedom Press Releases 

• In 2012, John Glenn was awarded the 
Presidential Medal of Freedom by 
President Obama. 

• The medal is the highest civilian honor 
and is given to people who have made a 
lasting contribution to the nation. 

• At the ceremony, it was said that, "John 
Glenn's example has moved us all to look 
to new horizons with drive and 
optimism." 

  

http://video.wosu.org/video/2365048711/
http://oldpoliticals.com/ItemImages/000029/41347_lg.jpeg
https://www.whitehouse.gov/the-press-office/2012/04/26/president-obama-names-presidential-medal-freedom-recipients
https://www.whitehouse.gov/the-press-office/2012/05/29/remarks-president-presidential-medal-freedom-ceremony
https://www.whitehouse.gov/the-press-office/2012/05/29/remarks-president-presidential-medal-freedom-ceremony
https://www.whitehouse.gov/the-press-office/2012/05/29/remarks-president-presidential-medal-freedom-ceremony
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